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ВВЕДЕНИЕ 
 
 Современный инженер, занимающийся гидродинамикой, обязан 
обладать навыками работы с современными программными комплек-
сами, позволяющими выполнять численное моделирование сложных 
гидродинамических процессов. К настоящему времени разработано 
большое количество таких CFD комплексов, как STAR-CD, 
FlowVision, N3S, CFX, Fluent, FemLab, FEATFLOW и др. В последнее 
время широкое распространение получили программные комплексы от 
компании Ansys, успешно продвигающейся на рынке специализиро-
ванных программных продуктов. 
 Целью данного учебного пособия является описание приемов рабо-
ты с основными элементами программного комплекса ANSYS, такими 
как ANSYS Workbench, DesignModelier, Meshing и Fluent, на примере 
решения трех задач гидрогазодинамики: задачи о ламинарном течении 
вязкой несжимаемой жидкости в трубе постоянного сечения, задачи о 
турбулентном течении вязкой несжимаемой жидкости в трубе посто-
янного сечения и задачи о косой ударной волне, образующейся при 
натекании на клин идеального сжимаемого газа. Следует отметить, что 
данное пособие не претендует на полноту описания всех возможных 
приемов и средств, заложенных в пакет Ansys, для решения задач гид-
родинамики. В пособии приводится описание работы в Ansys версии 
14.0, хотя к моменту написания пособия уже имеется версия 18, отли-
чающаяся интерфейсом от рассматриваемой. Тем не менее, навыки 
работы с интерфейсом ANSYS версии 14.0 позволяют без особого тру-
да работать с более поздними версиями ANSYS.  
 Пособие направлено на формирование общепрофессиональных и 
профессиональных компетенций в области численного моделирования 
гидродинамических процессов у магистрантов, обучающихся  по на-
правлениям 16.04.01 – Техническая физика и 24.04.03 – Баллистика и 
гидроаэродинамика. 
 Пособие будет также полезно аспирантам и слушателям курсов 
повышения квалификации, изучающих вычислительную гидродина-
мику.  
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1. ЛАМИНАРНОЕ ТЕЧЕНИЕ ВЯЗКОЙ НЕСЖИМАЕМОЙ 
ЖИДКОСТИ В КРУГЛОЙ ТРУБЕ 

1.1. Описание задачи 

 Рассмотрим задачу о ламинарном течении жидкости в круглой тру-
бе постоянного сечения, рис.1.1. Диаметр трубы D = 0.2 м, длина тру-
бы L = 8 м. Скорость жидкости на входе в трубу Uz  = 1 м/сек является 
постоянной по всему входному сечению. Жидкость вытекает в окру-
жающую среду, давление которой равно 1 атм. Примем плотность сре-
ды ρ = 1  кг/м3, а коэффициент вязкости µ = 2×10– 3 Па⋅с. Число Рей-
нольдса, построенное на основе диаметра трубы, равно 

Re 100z
U Dr
m

= =
. 

 Решим эту задачу, используя FLUENT с помощью ANSYS Work-
bench. Построим поля скорости и давления внутри трубы, и проверим 
полученные результаты. 
 

 
Рис. 1.1 

 
1.2. Предварительные замечания 

 Мы предполагаем, что вязкий пограничный слой нарастает вдоль 
трубы от входного участка. В конечном итоге, он вырастает настолько, 
что полностью заполняет трубу (при условии, что труба достаточно 
длинная). Когда это происходит, поток становится полностью разви-
тым, и профиль скорости в осевом направлении, х не изменяется (см. 
рис. 1.2). Из курса гидромеханики известно, что в полностью развитой 
области течения существует аналитическое решение основных урав-
нений гидромеханики.  

Uz 

L 

D 
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 Мы будем сравнивать численные результаты в полностью развитой 
области течения с соответствующими аналитическими решениями.  
 Какое решение ожидается для осевой скорости и коэффициента 
трения в полностью развитой области течения на основе аналитиче-
ского решения? Какое получается численное решение для профиля 
скорости? 

 
Рис. 1.2 

 
 Мы создадим геометрию и сетку в ANSYS 14.0, которая является 
препроцессором для FLUENT, а затем считаем сетку во FLUENT и 
проведем решение задачи. 
 

1.3. Создание проекта в ANSYS Workbench 

1) Создаем папку pipe, в которой будут храниться все файлы, созда-
ваемые во время работы.  

2) Запускаем ANSYS Workbench:  

Start> All Programs> ANSYS 14.0> Workbench 14.0 

 На рис. 1.3 показано окно Workbench. В левой стороне окна Work-
bench будет находиться панель инструментов, заполненная системами 
для решения различных физических задач. Посредине будет находить-
ся пустое рабочее место, где можно будет организовать свой проект. В 
нижней правой части окна можно увидеть сообщения от ANSYS. 
3) Для создания проекта щелкните левой кнопкой мыши на Fluid 

Flow (FLUENT) в окне Analysis Systems и, удерживая ее, перетащи-

Пограничный слой 

Входной участок Участок полностью  
развитого течения 
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те значок в пустое пространство окна Project Schematic. После 
этого окно Workbench должно выглядеть так, как показано на рис. 
1.4. 

 

 

Рис. 1.3 
 

4) Сохраните проект под именем Laminar Pipe. 
5) В окне Project Schematic (окна Workbench) кликните правой кноп-

кой мышки на Geometry и выберите Properties, как показано на 
рис. 1.5. В правой части окна Workbench появится окно Property 
of Schematic. 

6) В окне Property of Schematic, рис. 1.6, в разделе Advance Geometry 
Options измените значение Analysis Type на 2D. Это означает, что 
далее будет выполняться построение двумерной области.  

7) В окне Project Schematic дважды кликните на  Geometry чтобы 
начать подготовку построения геометрической области. При этом 
произойдет запуск программы ANSYS Design Modeler. Вам будет 
предложено выбрать желаемую единицу измерения длины, рис. 
1.7. Выберите метры и нажмите ОК. 
 



9 
 

 

Рис. 1.4 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 1.5. 
 

Рис. 1.5 



10 
 

 

Рис. 1.6 
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Рис. 1.7 

 
1.4. Создание эскиза в Design Modeler 

1) Открывшееся окно программы Design Modeler имеет вид, рис. 1.8. 
2) В панели Graphics в нижнем правом углу кликните левой кнопкой 

мыши по оси +Z. После этого плоскость ХY совпадет с плоско-
стью экрана. (Ось +Z будет смотреть на вас), рис. 1.9. 

3) Чтобы приблизить или отдалить изображение на панели Graphics, 
следует кликнуть левой кнопкой мыши по панели и, вращая коле-
сико мышки, можно добиться желаемого результата. Если возни-
кает необходимость переместить изображение влево, вправо, 
вверх, вниз, то следует кликнуть правой кнопкой мыши и в кон-
текстном меню выполнить следующую последовательность дей-

ствий: Cursor Mode→Pan. После этого курсор примет форму . 
Кликнув по панели Graphics левой кнопкой мыши и удерживая ее, 
можно перемещать изображение в любом направлении. 
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Рис. 1.8 

 

 

Рис. 1.9 
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4) Эскиз будем создавать в плоскости XY. Для этого на панели Tree 
Outline кликните по ХYPlane (рис. 1.9). В левом нижнем углу па-
нели Tree Outline выберите закладку Sketching. Вместо панели 
Tree Outline появится панель Sketching Toolboxes – панель инст-
рументальных средств для построения эскиза, рис. 1.10. По умол-
чанию открывается набор инструментов Draw. 
 

Рис. 1.10            Рис. 1.11 
 

5) Перед построением области покажем координатную сетку. Для 
этого на панели Sketching Toolboxes кликните по табулятору Set-
tings, находящемуся внизу панели, затем – по инструменту Grid и 
напротив Show in 2D установите галочку, рис. 1.11. После этого 
на панели Graphics будет показана координатная сетка, расстоя-
ние между координатными линиями по умолчанию равно 5 м. 
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6) На панели Sketching Toolboxes выберите Rectangle. На панели 
Graphics создайте прямоугольник, кликая левой кнопкой мыши в 
начале координат и, затем, где-нибудь в первом квадранте плос-
кости XY. Если курсор вести вдоль одной из осей, то рядом с кур-
сором появляется буква С, если курсор поместить в начало коор-
динат, то рядом с ним появляется буква Р. Приблизите рисунок, 
вращая колесико мышки, и сдвиньте его влево, рис. 1.12. 
 

 

Рис. 1.12 
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7) Нанесем размеры на прямоугольник. На панели Sketching 
Toolboxes выбираем табулятор Dimensions. На панели Graphics 
подводя курсор к верхней стороне прямоугольника, нажимая и 
удерживая левую кнопку мыши отводим курсор вверх. При этом 
появятся линии разметки. Такие же действия проделываем с ле-
вой стороной прямоугольника, только курсор отводим влево, рис. 
1.13. 

8) На панели Details View, которая находится под панелью Sketching 
Toolboxes, в группе Dimensions:2 устанавливаем H1=8, а V2=0.1, 
рис. 1.14. 

 
 

 

Рис. 1.13 
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Рис. 1.14 

 

1.4.1.  Создание поверхности 

1) Для создания поверхности выбираем в меню Concept, а затем Sur-
face From Sketches, как показано на рис. 1.15. 

2)  

 

Рис. 1.15 
 

3) На панели Tree Outline (закладка Modeling) кликните по Sketch1. 
4) На панели Details View, выберите Sketch1 как Base Objects и затем 

напротив Thickness (>=0) выберите толщину 0.1m и кликните Ap-
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ply. Окончательно кликните Generate, чтобы сгенерировать по-
верхность, рис. 1.16. 

5) На этом можно закрыть Design Modeler и вернуться в  Workbench 
Project Schematic для построения разностной сетки. 

 

 

Рис. 1.16 

 

1.4.2.  Построение сетки 

 Сетка будет состоять из 500 элементов, в продольном направлении 
выбираем 100 элементов, а в поперечном 5 элементов. 
1) В Workbench дважды кликаем по Mesh. При этом запускается 

программа Meshing, рис. 1.17. 
2) Сетку можно создать двумя способами: а) первый – кликнуть 

правой кнопкой мыши по Mesh в панели Outline и в контекстном 
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меню выбрать Generate Mesh, рис. 1.18; б) второй – кликнуть в 
строке инструментов, находящейся под главным меню на Mesh, а 
затем на Generate Mesh, рис. 1.19.  

 

 

Рис. 1.17 

 

 

Рис. 1.18 
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Рис. 1.19 
 
3) Результат будет выглядеть следующим: 

 
4) Далее применяют стиль Mapped Face Meshing. Чтобы включить 

этот стиль выполняют последовательность Mesh Control→ 
Mapped Face Meshing, рис. 1.20. 

5) Затем кликают по геометрической области, после чего она окра-
шивается в зеленый цвет: Если этого не происходит, то следует 
кликнуть по фильтру Face , находящейся на панели инструмен-
тов. После этого кликают Apply на панели Details of “Mapped Face 
Meshing”, рис. 1.21, после чего панель принимает вид, рис. 1.22, а 
геометрическая область окрашивается в фиолетовый цвет и при-
нимает вид, рис. 1.23. 
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Рис. 1.20 

 

 

Рис. 1.21 
 

 

Рис. 1.22 
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Рис. 1.23. 

1.4.3.  Задание узлов сетки на границе области 

1) Желаемая сетка имеет заданное число разбиений вдоль радиаль-
ного и осевого направлений. Для задания определенного числа 
разбиений следует использовать Edge Sizing. Сначала зададим 
число разбиений вдоль осевого направления. Для этого кликаем 
Mesh Control > Sizing как показано ниже, рис. 1.24. Панель Details 
of “Sizing” принимает вид, рис. 1. 25. 

 

  

Рис. 1.24 
 

 

Рис. 1.25 
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2) Сначала кликаем по фильтру Edge , который находится в 
панели инструментов под строкой меню, (доступ к этому фильтру 
можно получить и через контекстное меню в строке Cursor Mode). 
Затем подвдим курсор к нижней границе прямоугольника, (она 
при этом окрасится в зелены йцвет), нажимаем левую кнопку 
мыши, и не опуская ее переводим курсор к верхней границе 
прямоугольника. После этой процедуры обе границы должны 
быть окрашены в зеленый цвет. После этого кликаем Apply на па-
нели Details of “Sizing”, рис. 1.25. 

3) На панели Details of “Sizing” в строке Type выбираем Number of 
Divisions, рис. 1.26 и устанавливаем значение 100, рис. 1.27. 

 

 

Рис. 1.26 

 

Рис. 1.27 
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4) Проделываем аналогичную процедуру с п.1 по п.3 для левой и 
правой границы, с той лишь разницей, что в разделе Number of 
Divisions устанавливаем значение 5. 

5) Поле этого в строке меню кликаем Generate Mesh. После всех вы-
полненных операций окно программы Meshing будет выглядеть 
следующим образом: 
 

 

Рис. 1.28 
 

6) В разделе статистика панели Details of “Mesh” (предварительно 
кликнув на Mesh панели Outline) можно видеть, что число эле-
ментов получилось не равное 500. Программа автоматически по-
строила сетку, опираясь на минимальный размер шага вдоль ра-
диального направления. Чтобы получить ровно 500 элементов 
следует в разделе Behavior панелей Details of “Edge Sizing” и De-
tails of “Edge Sizing 2” сменить значение Soft на значение Hard. 
После чего выполнить Generate Mesh. 
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1.4.4.  Присвоение имен границам области  

 Левую границу области назовем Inlet, правую – Outlet, нижнюю – 
Axis, верхнюю Wall. Эти имена пригодятся на последующих шагах 
при построении модели с помощью программы Fluent. 
1) Выполнить клик правой кнопкой мыши по свободному полю, где 

нарисована область с построенной сеткой. Из строки Cursor Mode 

выбрать фильтр Edge . Подвести курсор к левой границе, ко-
гда она окрасится в зеленый цвет, выполнить левый клик мыш-
кой, после этого выполнить правый клик мышкой. В появившем-
ся контекстном меню выбрать Create Named Selection, рис. 1.29. 

2) Появится окно Selection Name, рис. 1.30, в которое следует ввести 
Inlet. Нажать ОК. Подобную операцию проделать со всеми грани-
цами, вводя соответствующие имена. 

 

          

      Рис. 1.29            Рис. 1.30 

 

1.4.5.  Сохранение, выход, обновление 

1) Сохраните проект. File→Save project 
2) Закройте окно Meshing. File→ Close Meshing. 
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3) Перейдите в окно Workbench и обновите проект, нажав на кнопку 

Update Project, , которая находится под строкой 
меню. 

 
1.5. Запуск ANSYS FLUENT 

 Схема вашего проекта (Project Schematic) в Workbench должна 
иметь вид примерно такой же, как показано на рис. 1.31. При этом на-
против Geometry и Mesh должны стоять галочки. 
1) Чтобы считать геометрию и сетку во FLUENT кликните правой 

кнопкой мыши по Setup и в контекстном меню выберите Refresh, 
рис. 1.32. 

2) После чего, вы кликаете на Update. В правой части ячейки Setup 
должен появиться знак вопроса, который означает, что процесс 
еще не завершен. 

3) Дважды кликните на Setup. Загрузится FLUENT Launcher. 
4) В разделе Options поставьте галочку рядом Double Precision, рис. 

1.33.  
5) Нажмите на ОК. FLUENT будет запущен. 
 

 
 
    Рис. 1.31         Рис. 1.32 
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Рис. 1.33 
 
 Во FLUENTе можно будет выбрать уравнения и установить крае-
вые условия, соответствующие рассматриваемой краевой задаче.  
 Рабочее окно FLUENTа имеет вид, показанный на рис. 1.34. 
 В левой части рабочего окна FLUENT находятся три основных 
элемента: Problem Setup, Solution и Results. С помощью этих элементов 
настраивают физическую модель, выбирают метод решения, обраба-
тывают результаты решения задачи. В правой части окна расположены 
панель графики и панель команд. В верхней части находится строка 
меню, через которую осуществляется доступ ко всем элементам пакета 
FLUENT. 
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Рис. 1.34 

 

1.5.1.  Проверка и изображение разностной сетки 

 Сначала необходимо проверить разностную сетку, чтобы убедить-
ся, что она была правильно импортирована из Workbench. 
1) Для получения статистики о сетке через строку меню выполните 

следующие действия Mesh→Info→Size. 
2) На панели команд появится информация о сетке, рис. 1.35. 
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Рис. 1.35. 
 

Сетка содержит 500 элементов, которые во FLUENTе называются 
ячейками (cells). 

3) Далее необходимо проверить сетку на наличие ошибок, для чего 
через меню следует выполнить команду Mesh→Check. На панели 
команд появится информация, рис. 1.36. 

 

 

Рис. 1.36 
 

Отсутствие сообщения об ошибке будет говорить о том, что раз-
ностная сетка была импортирована правильно. 

4)  Для изображения сетки в графическом окне следует в разделе 
Problem Setup, который находится в левой части рабочего окна, 
выбрать General, затем кликнуть по кнопке Display. Появится ок-
но Mesh Display,  рис. 1.37.  
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Рис. 1.37 

 
5) В разделе Surfaces окна Mesh Display выбрать все имеющиеся 

элементы (имена поверхностей) и нажать кнопку Display. В гра-
фическом окне будет показана разностная сетка. 

6) Для перемещения изображения расчетной области и разностной 
сетки следует кликнуть по изображению с левой кнопки мыши и, 
удерживая ее, переместить курсор в требуемое место. 

7) Для увеличения изображения следует кликнуть средней кнопкой 
мыши в верхний левый угол участка изображения и, удерживая ее 
провести курсор в нижний правый угол изображения.  Кнопку от-
пустить.  



30 
 

8) Для уменьшения изображения надо выполнить действия подоб-
ные п.7, только следует проводить курсором из нижнего правого 
угла изображения в верхний левый угол. 
 

1.5.2.  Внесение данных в решатель 

1) Задаем осесимметричную геометрию области. В разделе Gen-
eral→Solver→2D Space. 
2) Выбираем Axisymmetric, рис. 1.38. 
 

 

Рис. 1.38 

3) Устанавливаем модель вязкого ламинарного течения: Mod-
els→Viscous-Laminar→Edit. Откроется окно Viscous Model, в ко-
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тором выбираем значение Laminar, рис. 1.39. Кликаем ОК. (По 
умолчанию, во FLUENTe выбрана опция Laminar). 

 

 

Рис. 1.39 
 

 

Рис. 1.40 
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4) Отключаем уравнение энергии: Models→Energy→Edit, рис. 1.40. 

В нашем случае уравнение энергии решать не требуется. Поэтому 
нажимаем на Cancel. 

 

1.5.3.  Задание свойств жидкости 

 Свойства жидкости были указаны при постановке задачи.  
1) Для создания жидкости с такими свойствами выполняем следую-

щие действия: Materials→Fluid→Create/Edit, рис. 1.41.  
 

  

Рис. 1.41 
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2) В появившемся окне устанавливаем плотность 1 кг/м3 и вязкость 
0.002 кг/(м⋅сек), рис. 1.42. 

 
 

 

Рис. 1.42. 

3) Кликаем кнопку Change/Create, затем Close. 
 

1.5.4.  Задание граничных условий 

 По условию задачи необходимо задать условия на четырех грани-
цах: 
1) Задаем условия на входной границе: Boundary Conditions→Zone 

(Inlet)→Edit, рис. 1.43. Автоматически произойдет выбор значе-
ния velocity-inlet в разделе Type. 
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Рис. 1.43. 
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2) В появившемся окне Velocity Inlet, рис. 1.44 вбираем значение 
Velocity Specification Method равным Components и устанавливаем 
значение Axial-Velocity(m/s) равным 1. 

 

 

Рис. 1.44 
 

3) Кликаем OK и закрываем окно. 
4) Задаем условия на выходной границе: Boundary Condi-

tions→Outlet→Edit.  
5) Значение Gauge Pressure (pascal) устанавливаем равное 0. Клика-

ем OK. 
6) Задаем условия на оси симметрии: Boundary Conditions→Zone 

(axis). Меняем значение Type на axis, рис. 1.45. В появившемся 
окне Question кликаем Yes, а в окне Axis – на ОК. 

7) Как можно видеть зона wall имеет значение Type равное wall. Ес-
ли это не так, то необходимо под Type выбрать значение равное 
wall. 

9) После задания настроек, сохраните проект через строку меню 
File→Save Project.  
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1.5.5. Выбор разностной схемы 

 Для решения поставленной задачи мы будем использовать алго-
ритм SIMPLE метода Патанкара, с привлечением схемы второго по-
рядка точности для конвективных членов в уравнении сохранения им-
пульса.  

 

 

Рис. 1.45 
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 Для выбора разностных схем используется раздел Solution. Убеди-
тесь, что в подразделе Solution Methods установлены значения, пока-
занные на рис. 1.46. 
 

 

Рис. 1.46 

1.5.6.  Задание начальных условий 

1) В разделе Solution выбираем Solution Initialization. 
2) Меняем метод инициализации на Standard Initialization. 



38 
 

3) Кликаем на Compute from и выбираем inlet. 
4) Кликаем Initialize, рис. 1.47. 

1.5.7.  Настройка критерия сходимости 

 FLUENT выдает информацию о невязке для каждого решаемого 
уравнения. Невязка является мерой того, насколько хорошо текущее 
решение удовлетворяет дискретной форме основного уравнения. Мы 
будем итерировать каждое уравнение до тех пор, пока невязка не упа-
дет ниже 10–6. Для задания критерия невязки выполняем следующие 
действия. 
1) В разделе Solution выбираем Monitors. 
2) В разделе Monitors выбираем Residuals, и далее жмем кнопку Edit, 

рис. 1.48.  
3) В появившемся окне Residual Monitors изменяем значения Abso-

lute Criteria, расположенные напротив строк Residual для continui-
ty, x-velocity, y-velocity, на 10-6 рис. 1.49. 

 

 

Рис. 1.47 
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Рис. 1.48 
 
 



40 
 

 

Рис. 1.49 

 

1.5.8.  Расчет коэффициента трения 

 Коэффициент трения жидкости на поверхности определяется по 

формуле:
21

2

D
D

ref ref ref

F
C

V Ar
= . Здесь Aref – площадь цилиндрической 

поверхности канала, Vref – скорость потока на входе в канал, ρref – 
плотность жидкости, FD – сила трения на цилиндрической поверхно-

сти канала, 
u
d
n

m s¶
¶ò . Для нахождения коэффициента трения необ-

ходимо выполнить следующие действия: 
1) В разделе Solution выбираем Monitors. 
2) Под окном Residuals, Statistic and Force Monitors жмем кнопку 

Create и в выпадающем окне выбираем Drag, рис. 1.50. 
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Рис. 1.50 

3) В появившемся окне Drag Monitor в разделе Options устанавлива-
ем галочку напортив Print to Console. Это означает, что значение 
коэффициента трения будет выводиться в окно консоли. 

4) Устанавливаем галочку напротив Plot. При этом окно Window 
будет активировано и значение в окне будет изменено на 2, что 
означает, что будет создано 2-е графическое окно, в которое бу-
дет осуществляться вывод коэффициента трения. 

5) В окне Wall Zone выбираем wall, рис. 1.51. 
6) Закрываем окно Drag Monitor, нажав ОК. 
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Рис. 1.51 

 Чтобы коэффициент трения правильно рассчитывался необходимо 
найти площадь цилиндрической поверхности канала Aref, задать Vref  и 
ρref . 
1) . Для этого выбираем раздел Reports, далее – Surface Integrals, на-

жимаем кнопку Set Up, рис. 1.52. 
2) В появившемся окне Surface Integrals, в разделе Report Type вы-

бираем Area, а в разделе Surfaces выбираем wall. Жмем кнопку 
Compute. 

3) В окне Area (m2) появится значение площади цилиндрической 
поверхности, которая имеет имя wall, рис. 1.53.  Это же значение 
будет напечатано в командном окне FLUETa, рис. 1.54. 
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Рис. 1.52 
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Рис. 1.53 
 

 

Рис. 1.54 
 

4) Копируем значение площади поверхности.  Закрываем окно Sur-
face Integrals, нажав на кнопку Close. 

5) Переходим в раздел Problem Setup. Выбираем подраздел Refer-
ence Values, рис. 1.55. 

6) Вставляем скопированное значение площади в строку Area (m2).  
7) В строках Density (kg/m3), Velocity (m/s) задаем значения 1. 
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Рис. 1.55 

1.5.9. Выполнение расчетов 
 Перед выполнением расчетов необходимо задать число итераций. 
Для этого 
1)  В разделе Solution выберите Run Calculation. 
2)  В строке Number Iterations задайте число итераций 100. 
3) Сохраните проект, File →Save Project. 
4) Нажмите кнопку Calculate, рис. 1.56. 
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Рис. 1.56 

5) Невязки на каждой итерации будут выводиться в окно консоли и 
строиться в виде зависимостей от номера итерации в графическом 
окне. 

6) Значение коэффициента трения Cd-1 будет выведено в окно кон-
соли и построено во втором графическом окне, рис. 1.57. 

7) Сохраните проект, File →Save Project. 
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Рис. 1.57 

1.6. Обработка результатов расчета с помощью средств 
FLUENTa 

 Результаты расчетов можно обработать либо с помощью средств 
встроенных FLUENT, либо с помощью ANSYS постпроцессора CFD-
Post. 

1.6.1. Построение поля векторов скоростей 

1)  В разделе Results выбираем подраздел Graphics and Animations.   
2) В окне Graphics выбираем Vectors и жмем кнопку Set Up, рис. 

1.58. 
3) В появившемся окне Vectors, рис. 1.59. жмем кнопку Display. В 

графическом окне будет показано поле векторов скоростей. 
4) Приблизить или увеличить изображение можно путем выделения 

прямоугольной области, зажав среднюю кнопку мыши, и проводя 
курсором из левого верхнего угла в нижний правый угол, рис. 
1.60. Обратная операция позволяет отдалить или уменьшить изо-
бражение. 

5) Длина векторов регулируется коэффициентом, стоящим в поле 
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Scale окна Vectors. После изменения значения коэффициента сле-
дует нажать кнопку Display. 

6) Закройте окно Vectors, нажав на кнопку Close. 
 
 

 
 

Рис. 1.58 
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Рис. 1.59 

 

Рис. 1.60 
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1.6.2. Построение изолиний модуля скорости  

 Для построения изолиний модуля скорости следует выполнить та-
кие действия: 
1) В разделе Results выбираем подраздел Graphics and Animations.   
2) В окне Graphics выбираем Contours и жмем кнопку Set Up, рис. 

1.61. 
3) В появившемся окне Contours  в разделе Contours of выбираем 

Velocity и Velocity Magnitude. Жмем кнопку Display, рис. 1.62. 
4) В графическом окне будут изображены изолинии модуля скоро-

сти, рис. 1.63. 
 

 
 

Рис. 1.61 
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Рис. 1.62 

 

Рис. 1.63 
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5) Количество построенных изолиний можно изменить, указав тре-

буемое число (не более 100) в поле Levels, после чего нажать 
кнопку Display. 

6) Поле модуля скорости можно представить в виде зон, в которых 
пространство между изолиниями окрашено в определенный цвет, 
соответствующий значению модулю скорости, указанному на 
шкале, расположенной в левой части графического окна. Для это-
го в окне Contours в разделе Options следует установить галочку 
рядом с Filled и нажать на кнопку Display, рис. 1.64. В графиче-
ском окне появится окрашенное поле контуров модуля скорости, 
рис. 1.65. 
 

 

Рис. 1.64 
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Рис. 1.65 
 

 

Рис. 1.66 
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1.6.3. Построение профиля скорости на выходе из канала 

1) В разделе Results выбираем Plots. В поле Plots выбираем XY Plot, 
рис. 1.66. 

2) Жмем кнопку Set Up Появиться окно Solution XY Plot. 
3) В окне Solution XY Plot  настраиваем опции, как показано на рис. 

1.67. 
 

 

Рис. 1.67 
 

4) Нажимаем кнопку Plot, в графическом окне будет изображен 
профиль осевой скорости. По оси абсцисс будет отложена про-
дольная скорость, а по оси ординат – радиальная координата, рис. 
1.68. 

5) Для более наглядного представления полученного профиля ско-
рости можно соединить точки линиями. Для этого в окне Solution 
XY Plot, рис. 1.67, следует нажать кнопку Curves .  

6) В появившемся окне Curves - Solution XY Plot выбрать значение 
Pattern раздела Line Style, как показано на рис. 1.69. 
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Рис. 1.68 

 

 

Рис. 1.69 
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7) Нажать кнопку Apply. После чего нажать кнопку Plot в окне Solu-
tion XY Plot. В графическом окне будет изображен профиль про-
дольной скорости на выходе из канала, рис. 1.70. 

 

 

Рис. 1.70 
 
 

1.6.4. Построение изменения давления вдоль оси канала 

 Для построения графика изменения давления вдоль оси канала по-
ступаем аналогично предыдущему пункту. 
1) Results→Plots→XY Plots→Set Up 
2) Настраиваем опции окна Solution XY Plot так, как показано на 

рис. 1.71. 
3) Жмем кнопку Plot. В графическом окне будет показан требуемый 

график, рис. 1.72. 
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Рис. 1.71 
 

 

Рис. 1.72 
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1.6.5. Контроль и проверка решения 

 При проведении расчета мы контролировали значение невязок для 
каждого из уравнений. По достижении всех невязок значения меньше-
го, чем 10–6, мы полагаем, что итерационный процесс сошелся, и мы 
получили численное решение. Невязка, в данном случае, является кос-
венной характеристикой. Мы можем убедиться в правильности реше-
ния исходной системы уравнений Навье Стокса, если проверим инте-
гральное выполнение законов сохранения массы и импульса.  
 Уравнение неразрывности, которое отражает закон сохранения 
массы, имеет вид: 

0
r U r V

x r

r r¶ ¶+ =
¶ ¶

. 

 Умножим уравнение на 2π, проинтегрируем его по r от 0 до R и по 
х от 0 до L. Применим формулу Грина:  

0 0

2
L R

r U r V
dxdr

x r

r rp
æ ö¶ ¶ ÷ç ÷+ =ç ÷ç ÷ç ¶ ¶è øò ò ( )2 0r Vdx r Udrp r r- + =ò . 

Расписывая контурный интеграл по границе области, получим 
0 0

0 0
0 0

2 2 2 2 0
L R

r r R x L x
L R

r V dx r V dx r U dr r U drp r p r p r p r
= = = =

- - + + =ò ò ò ò . 

 Первые два слагаемых обращаются в 0, т.к. и на оси симметрии, и 
на стенке, радиальная скорость жидкости равна 0, тогда получим: 

0
0 0

2 2 0
R R

x L x
r U dr r U drp r p r

= =
- =ò ò . 

 Это означает, что для проверки закона сохранения массы мы долж-
ны убедиться в том что, сколько жидкости в область втекло, столько 
же должно из нее и вытечь. Для этого выполним следующую последо-
вательность действий: Reports→Fluxes→Set Up, рис. 1.73. Появится 
окно Flux Reports, в котором выделяем границы inlet и outlet и жмем 
кнопку Compute, рис. 1.74. В поле Results появятся значения потоков 
массы (кг/сек) для каждой границы, а в поле Net Results – сумма этих 
потоков. Обратите внимание на то, что поток массы на выходной гра-
нице отрицательный, что говорит о вытекании жидкости из области. 
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Интегральную ошибку расчета по массе в процентах можно опреде-
лить как отношение суммы потоков на границах области к потоку на 
входной границе, умноженное на 100. 

 

 

Рис. 1.73 
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Рис. 1.74 
 

 Проверим теперь выполнение закона сохранения импульса для 
продольной компоненты вектора скорости. Уравнение импульса в 
продольном направлении можно записать в виде: 

2 0U U
r U P r UV

x x r r
r m r m

é ù é ùæ ö æ ö¶ ¶ ¶ ¶÷ ÷ç çê ú ê ú÷ ÷+ - + - =ç ç÷ ÷ê ú ê úç ç÷ ÷ç ç¶ ¶ ¶ ¶è ø è øê ú ê úë û ë û
. 

 Повторяя те же самые действия, что мы делали с уравнение нераз-
рывности, получим: 

0

0 0
0

2 2

0 0

2 2

2 2 0

L

Lr r R
R

Rx L x

U U
r UV dx r UV dx

r r

U U
r U P dr r U P dr

x x

p r m p r m

p r m p r m

= =

= =

æ ö æ ö¶ ¶÷ ÷ç ç÷ ÷- - - - +ç ç÷ ÷ç ç÷ ÷ç ç¶ ¶è ø è ø
æ ö æ ö¶ ¶÷ ÷ç ç÷ ÷+ + - + + - =ç ç÷ ÷ç ç÷ ÷ç ç¶ ¶è ø è ø

ò ò
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 Учитывая, что на входе в канал и на выходе из канала 0
U

x

¶ =
¶

, и 

на поверхности канала V=0, получим: 

( ) ( )
0

2 2

0
0 0

2 2 2 0
R R

x L x
L r R

U
r dx r U P dr r U P dr

r
p m p r p r

= =
=

æ ö¶ ÷ç ÷ + + - + =ç ÷ç ÷ç ¶è øò ò ò
 Первое слагаемое полученного соотношения представляет собой не 
что иное, как силу трения жидкости о боковую цилиндрическую по-
верхность канала, а другие два – разность потоков импульса жидкости 
на выходе и входе в канал. 

 

Рис. 1.75 
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 Для нахождения силы трения следует выполнить Re-
ports→Forces→Set Up , рис. 1.75. В появившемся окне Force Reports 
настроить опции, как показано на рис. 1.76, и нажать кнопку Print. В 
окне консоли будет выведена информация о силе трения на боковой 
поверхности, которой мы дали имя wall, рис. 1.77. 
 Для нахождения потоков импульса через входную и выходную гра-
ницы создадим новую переменную под названием impulse. Для этого 
через строку меню выполним Define →Custom Field Functions, рис. 
1.78.  
 

.  

Рис. 1.76 

 

 
Рис. 1.77 
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Рис. 1.78 
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Рис. 1.79 
 

 Откроется окно Custom Field Functions Calculator, рис. 1.79. В этом 
окне с помощью значений поля Field Functions, кнопки Select и кнопок 
калькулятора и создаем выражение density*axial-velocity^2+p, которое 
появится в поле Definition, и этому выражению в поле New Function 
Name даем имя impulse. Жмем кнопку Define. Далее выполняем дейст-
вия: Results→Reports→Surface Integrals→Set Up появится окно Surface 
Integrals. В этом окне в поле Reports Type выбираем Integrals. В поле 
Field Variable выбираем Custom Field Functions и затем имя созданной 
нами переменной impulse. В поле Surfaces выбираем inlet и outlet. 
Жмем кнопку Compute, рис. 1.80. 
 В окне консоли появятся значения потока импульса на входе и вы-
ходе из канала, рис. 1.81. 
 Находим разность между потоками импульса на выходе и входе в 
канал: 0.395444201. Сравним полученное изменение потоков импульса 
с силой, действующей на боковую поверхность 0.39561415. Видим, 
что погрешность не превосходит 0.04%. 
 Закройте FLUENT: File→Close FLUENT. 
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Рис. 1.80 
 

 

Рис. 1.81 
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1.7. Измельчение сетки 

 Получим решение на более мелкой сетке, для чего увеличим число 
разбиений в радиальном направлении с 5 до 10.  

1) Для этого надо кликнуть правой кнопкой мыши на схеме про-
екта по Mesh и выбрать Dublicate, рис. 1.82. 

2) Появиться новая страница проекта. Переименуем ее в Laminar 
Pipe (mesh2), рис. 1.83. 

3) Кликаем по Mesh в странице Laminar Pipe (mesh2).  
4) На панели Details of “Mesh” в разделе Sizing значение строки 

Use Advanced Size Function изменяем на Off. 
5) Увеличиваем число разбиений в радиальном направлении. 
6) Число ячеек должно равняться 1000. Это можно увидеть на 

панели Details of “Mesh” в разделе Statistics в правой части 
строки Elements. 

7) Закрываем программу Meshing. 
 

 

Рис. 1.82 
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Рис. 1.83 

 
1.8. Просмотр результатов 

1) На схеме проекта Laminar Pipe (mesh2) выполняем правый клик 
по строке Fluid Flow (FLUENT) и в контекстном меню выбираем 
Update. 

2) Ждем некоторое время, пока FLUENT проведет весь расчет. За-
пускаем FLUENT снова. Анализируем результаты. 

 
1.9. Задание для самостоятельной работы 

 Решите задачу о развитии течения несжимаемой жидкости в трубе 
длиной 8 метров, диаметром 0.2 метра. Плотность жидкости 1 кг/м3, 
вязкость жидкости 0.002 Па⋅с, скорость жидкости на входе в трубу 1 
м/с. 
 Для решения используйте FLUENT, схему второго порядка аппрок-
симации для уравнения сохранения импульса. Решение требуется по-
лучить на разностных сетках 100 × 5, 100 × 10 и 100 × 20, (осевое раз-
биение × радиальное разбиение). 
 
1.  Постройте профили осевой скорости на выходе из трубы, получен-
ные на трех различных сетках. Также постройте профиль скорости, 
полученный из решения задачи о развитом течении несжимаемой жид-
кости в трубе постоянного сечения. На одном графике должно быть 4 
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кривых. Осевая скорость должна быть отложена на оси абсцисс, а ра-
диальная координата – по оси ординат.  

2.  Рассчитайте сдвиговое напряжение 
xy
t на стенке в области полно-

стью развитого течения на трех сетках. Рассчитайте это значение из 
теории полностью развитого течения жидкости в трубе. Для каждой 
сетки рассчитайте ошибку относительно аналитического решения. 
Поместите результаты расчетов в таблицу:  
 

Сетка 
xy
t  % ошибка 

   

3.  На выходе из трубы, где течение полностью развитое, ошибку в 
осевой скорости на оси симметрии можно определить как 

calc exact

exact

u u

u
e

-
= �

�
 

Ожидается, что ошибка будет иметь вид: pK re = D , rD  – размер 
ячейки в радиальном направлении, K и p – постоянные, значение кото-
рых будет зависеть от выбранной разностной схемы. Используя метод 
наименьших квадратов, предварительно прологарифмировав зависи-
мость ln ln lnK p re = + ⋅ D , найти постоянные K и p. 
4.  Посмотрите, как изменится значение p при смене разностной схемы 
с "second-order upwind" на "first-order upwind". На графике должно 
быть изображено четыре кривые. По две для каждой разностной схе-
мы. Сравните значения p и дайте объяснение полученным результатам. 
Следует помнить, что схемы второго и первого порядка точности при-
меняются только для инерционных членов уравнения сохранения им-
пульса, а дискретизация вязких членов всегда имеет второй порядок 
точности. 

Справочная информация 
 Профиль скорости полностью развитого ламинарного течения вяз-
кой несжимаемой жидкости в круглой трубе радиуса R определяется 
по формуле: 
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2

2
( ) 2 1

av

y
u y u

R

æ ö÷ç ÷= -ç ÷ç ÷÷çè ø� , 

где uav – средняя по сечению трубы скорость течения жидкости. В рас-
сматриваемой задаче эта скорость равна скорости жидкости на входе в 
трубу. 
 Сдвиговое напряжение жидкости на стенке трубы находится из 
выражения: 

4( ) av
w xy

y R

uu y

y R
t t m m

=

æ ö¶ ÷ç ÷º = = -ç ÷ç ÷ç ¶è ø
�  

 Сила трения, действующая со стороны жидкости на стенку трубы, 
определяется по формуле: 

0

2 8
L

fric w w av

S

F ds R dx u Lt p t p m= - = - = ⋅ ⋅ ⋅ ⋅ò ò
���

� � . 

 Коэффициент трения жидкости о поверхность трубы определяется 
по формуле: 

2 21 1
2 2

8 16
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F u L
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u S u D L

p m
r r p
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где Re
av
u Dr m= � . 
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2. ТУРБУЛЕНТНОЕ ТЕЧЕНИЕ ВЯЗКОЙ НЕСЖИМАЕМОЙ 
ЖИДКОСТИ В КРУГЛОЙ ТРУБЕ 

2.1. Описание задачи 

 Рассмотрим задачу о турбулентном течении жидкости в круглой 
трубе постоянного сечения, рис. 2.1. Диаметр трубы D = 0.2 м, длина 
трубы L = 8 м. Скорость жидкости на входе в трубу Uz  = 1 м/сек явля-
ется постоянной по всему входному сечению. Жидкость вытекает в 
окружающую среду, давление которой равно 1 атм. Примем плотность 
среды ρ = 1 кг/м3, а коэффициент вязкости µ = 2×10–5 Па⋅с. Число Рей-
нольдса, построенного на основе диаметра трубы равно: 

Re 10000z
U Dr
m

= =
. 

При таких значениях числа Рейнольдса течение в трубе будет полно-
стью турбулентным. 
 Решим эту задачу, используя FLUENT с помощью ANSYS Work-
bench. Построим поля скорости и давления внутри трубы, и проверим 
результаты. 
 

 
Рис. 2.1 

2.2. Предварительные замечания 

 При турбулентном течении возникают мелко-масштабные по вре-
мени пульсации. Обычно, эти пульсации не удается разрешить, приме-
няя средства вычислительной гидродинамики. Поэтому такие пере-
менные потока, как скорость, давление и т.д., усредняются по времени. 
К сожалению, усредненные по времени определяющие уравнения не 
замыкаются. (Т.е. они содержат пульсационные величины, которые 

Uz 

L 

D 
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нужно определить с помощью каких либо моделей турбулентности). 
До сих пор не существует единой модели турбулентности, которая бы 
была справедлива для всех типов течений, и поэтому необходимо вы-
бирать и настраивать модель для конкретного класса течений. 
 В данном задании рассматриваются только, так называемая, k-ε 
модель турбулентности. При решении же практических задач необхо-
димо проводить тщательный анализ вида течения, чтобы обосновано 
выбрать ту или иную модель турбулентности. k-ε модель турбулентно-
сти включает в себя два уравнения – для турбулентной кинетической 
энергии k, и для скорости диссипации турбулентной энергии ε. Эти два 
уравнения решаются совместно с осредненными по времени уравне-
ниями неразрывности, импульса и энергии. Расчеты турбулентных 
течений занимают гораздо больше времени, чем расчеты ламинарных 
течений. 

2.3. Создание проекта в ANSYS Workbench 

1) Запускаем ANSYS Workbench:  

Start> All Programs> ANSYS 14.0> Workbench 14.0. 

На рис. 2.2 показано окно Workbench: 
 

 

Рис. 2.2 
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В левой стороне окна Workbench будет находиться панель инструмен-
тов, заполненная системами для решения различных физических задач. 
Посредине будет организован создаваемый проект. В окне Analysis 
Systems дважды щелкаем по строке Fluid Flow (FLUENT). Окно 
Workbench будет выглядеть как на рис. 2.3. 
 

 

Рис. 2.3 
 
2) В окне Property of Schematic, в разделе Advance Geometry Options 

измените значение Analysis Type на 2D, поскольку далее мы будем 
использовать двумерную модель. 

3) Сохраните проект под именем Turbulent Pipe. 
4) В окне Project Schematic (окна Workbench) кликните правой кноп-

кой мышки на Geometry и выберите Properties, как показано на рис. 
2.4. В правой части окна Workbench появится окно Property of 
Schematic. 

5) Импортируем геометрию из задачи о ламинарном течении жидко-
сти в трубе. В окне Project Schematic кликаем правой кнопкой мы-
ши по Geometry и в появившемся окне выбираем Import Geometry, 
затем выбираем Browse, рис. 2.5: 
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Рис. 2.4 

 

 

Рис. 2.5 
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6) В появившемся окне выбираем файл, в котором хранится геометрия 
трубы, созданная нами в предыдущей задаче, рис. 2.6. 

 

 

Рис. 2.6 

7) В окне проекта кликаем правой кнопкой мыши по строке Mesh и 
далее Edit, рис. 2.7. После этого откроется окно Meshing. 

 

 

Рис. 2.7 
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2.4.  Построение сетки 

 Сетка будет состоять из 3000 элементов, в продольном направле-
нии выбираем 100 элементов, а в поперечном 30 элементов. Сетку по-
строим так, чтобы она сгущалась к стенке. 
1) Генерируем сетку: Generate Mesh. 
2) Применяем стиль Mapped Face Meshing. Чтобы включить этот 

стиль выполняют последовательность Mesh Control→ Mapped Face 
Meshing, рис. 2.8. 

3) Кликаем по геометрической области, после чего она окрашивается 
в зеленый цвет. После этого кликаем Apply на панели Details of 
“Mapped Face Meshing”, рис. 2.9.  

 

 

Рис. 2.8 
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Рис. 2.9 

2.4.1.  Задание узлов сетки на границе области 

1) Сначала зададим число разбиений вдоль осевого направления. Для 
этого кликаем Mesh Control > Sizing. 

2) Кликаем по фильтру Edge . Затем подвдим курсор к нижней 
границе прямоугольника, (она при этом окрасится в зелены йцвет), 
нажимаем левую кнопку мыши, и не опуская ее переводим курсор к 
верхней границе прямоугольника. После этой процедуры обе 
границы должны быть окрашены в зеленый цвет. После этого 
кликаем Apply на панели Details of “Sizing”. 

3) На панели Details of “Sizing” в поле Type выбираем Number of Divi-
sions и устанавливаем значение 100. 

4) Значение поля Behavior меняем на Hard. 
5) Проделываем аналогичную процедуру с п.1 по п.2 для левой грани-

цы. На панели Details of “Sizing” в строке Type выбираем Number of 
Divisions и устанавливаем значение 30. 

6) Значение поля Behavior меняем на Hard. 
7) Значение поля Bias Type меняем на , а значение 

поля Bias Factor устанавливаем равным 10. 
8) Проделываем те же операции, что и в п.5-7 для правой границы, с 

той лишь разницей, что значение поля Bias Type выбираем: 
. 

9) Поле этого в строке меню кликаем Generate Mesh. После всех вы-
полненных сетка будет иметь вид: 

10) В разделе статистика панели Details of “Mesh” можно видеть, что 
число элементов получилось 3000. 



77 
 

 

Рис. 2.10 

2.4.2.  Присвоение имен границам области  

 Левую границу области назовем Inlet, правую – Outlet, нижнюю – 
Axis, верхнюю Wall. Эти имена пригодятся на последующих шагах 
при построении модели с помощью программы Fluent. 
1) Выполнить клик правой кнопкой мыши по свободному полю, где 

нарисована область с построенной сеткой. Из строки Cursor Mode 

выбрать фильтр Edge . Подвести курсор к левой границе, когда 
она окрасится в зеленый цвет, выполнить левый клик мышкой, по-
сле этого выполнить правый клик мышкой. В появившемся контек-
стном меню выбрать Create Named Selection, рис. 2.11. 

2) Появится окно Selection Name, рис. 2.12, в которое следует ввести 
Inlet. Нажать ОК. Подобную операцию проделать со всеми грани-
цами, вводя соответствующие имена. 
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Рис. 2.11          Рис. 2.12 

 

2.4.3.  Сохранение, выход, обновление 

1) Сохраните проект. File→Save project 
2) Закройте окно Meshing. File→ Close Meshing. 
3) Перейдите в окно Workbench и обновите проект, нажав на кнопку 

Update Project, , которая находится под строкой 
меню. 

4) Окно проекта примет вид, рис. 2.13:  
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Рис. 2.13 

 

2.5. Запуск ANSYS FLUENT 

1) Чтобы считать геометрию и сетку во FLUENT кликните правой 
кнопкой мыши по Setup и в контекстном меню выберите Refresh 

2) После чего, следует кликнуть на Update. В правой части ячейки 
Setup должен появиться знак вопроса, который означает, что про-
цесс еще не завершен. 

3) Дважды кликните на Setup. Загрузится FLUENT Launcher. 
4) В разделе Options поставьте галочку рядом Double Precision  
5) Нажмите на ОК. FLUENT будет запущен. 
6) Проверяем информацию о разностной сетке Mesh→Info→Size. 
7) Проверяем сетку на наличие ошибок Mesh→Check, 

2.5.1.  Внесение данных в решатель 

1) Задаем осесимметричную геометрию области. В разделе Gen-
eral→Solver→2D Space выбираем Axisymmetric.  

2) Отключаем уравнение энергии: 
 Problem Setup → Models→ Energy→Off. 
3) Устанавливаем модель турбулентного течения: Problem Setup → 

Models→Viscous-Laminar→Edit.  Откроется окно Viscous Model, в 
котором выбираем значение k-epsilon (2 eqn), рис. 2.14.  
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4) В группе Near Wall Treatment выбираем модель неравновесных 
пристеночных функций:  Enhanced Wall Function. В этом случае 
выбор пристеночных функций будет происходить в зависимости от 
того какова величина y+. Будут использованы либо стандартные 
пристеночные функции (30<y+.<100), либо функции, соответст-
вующие двухслойной модели (y+<30). 

5) Кликаем ОК. 

2.5.2. Задание свойств жидкости 

 Свойства жидкости были указаны при постановке задачи.  
4) Для создания жидкости с такими свойствами выполняем следую-

щие действия: Problem Setup → Materials → Fluid → Create/Edit.  
5) В появившемся окне устанавливаем плотность 1 кг/м3 и вязкость 

2⋅10–5 кг/(м⋅сек).  
6) Кликаем кнопку Change/Create, затем Close. 
 

 

Рис. 2.14 



81 
 

2.5.3.  Задание граничных условий 

 По условию задачи необходимо задать условия на четырех грани-
цах. 
1) Задаем условия на входной границе: Problem Setup→Boundary Con-

ditions→Zone (Inlet)→Edit, как показано на рис. 2.15. Задание ско-
рости на входе 1 м/сек обеспечивает Re=10000.  

2) В разделе Turbulence в строке Specification Method выбираем значе-
ние Intensity and Hydraulic Diameter. Устанавливаем значение Tur-
bulent Intensity равным 1%, а Hydraulic Diameter 0.2 м. 

 

 

Рис. 2.15 
 

3) Кликаем на ОК. 
4) На всех других границах устанавливаем те же значения, что и в 

предыдущей задаче. 
5) После задания настроек, сохраните проект через строку меню 

File→Save Project.  
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2.5.4.  Выбор разностной схемы 

 Для решения поставленной задачи мы будем использовать алго-
ритм SIMPLE метода Патанкара, с привлечением противопоточной 
схемы второго порядка точности для конвективных членов в уравне-
нии сохранения импульса, для уравнения кинетической турбулентной 
энергии и уравнения диссипации турбулентной энергии. 
 В разделе Solution выбираем Solution Methods. Значения соответст-
вующих полей должны быть выбраны так, как показано на рис. 2.16. 
 

 
Рис. 2.16 

 
 



83 
 

2.5.5. Настройка критерия сходимости 

 Мы будем итерировать каждое уравнение до тех пор, пока невязка 
не упадет ниже 10–6. Для задания критерия невязки выполняем сле-
дующие действия. 
1) Solution → Monitors → Residuals, Statistic and Force Monitors → Re-

siduals→ Edit. 
2) В появившемся окне Residual Monitors изменяем значения Absolute 

Criteria, расположенные напротив строк Residual для continuity, x-
velocity, y-velocity, k и epsilon на 10–6 рис. 2.17. 

3) В разделе Options ставим галочки напротив Print to Console и Plot. 
4) Жмем на ОК. 
 

 

Рис. 2.17 

 

2.5.6.  Задание начальных условий 

1) В разделе Solution выбираем Solution Initialization. 
2) Меняем метод инициализации на Standard Initialization. 
3) Кликаем на Compute from и выбираем inlet. 
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4) Кликаем Initialize. 

2.5.7. Сохранение проекта  

File → Save Project 

2.5.8.  Выполнение расчетов 

 Задаем число итераций равное 700 
1)  Solution → Run Calculation. 
2)  В строке Number Iterations задайте число итераций 700. 
3) Нажмите кнопку Calculate. 
4) Невязки на каждой итерации будут выводиться в окно консоли и 

строиться в виде зависимостей от номера итерации в графическом 
окне, рис. 2.18. Решение сойдется за 220 итераций. Здесь понадоби-
лось больше итераций, чем при решении задачи о ламинарном те-
чении, т.к. здесь была использована более мелкая разностная сетка. 

 

Рис. 2.18 
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2.6. Обработка результатов расчета 
 Обработаем результаты расчетов с помощью средств встроенных 
во FLUENT 

2.6.1. Расчет местного коэффициента трения 

 В примере о ламинарном течении в трубе мы показывали, как мож-
но строить распределения каких либо параметров вдоль трубы или 
поперек трубы. По умолчанию FLUENT содержит определенный 
(стандартный) набор параметров, распределение которых можно по-
смотреть, например, давление, скорость, сдвиговое напряжение на 
стенке трубы и т.д. Другой набор параметров (дополнительный) требу-
ется подключать. Например, если мы хотим вывести распределение 
местного коэффициента трения на поверхности трубы, то через меню 
выполняем следующие действия:  
1) File→Data File Quantities, как показано на рис. 2.19. Откроется окно 

Data File Quantities.  
2) В разделе Additional Quantities этого окна выбираем Skin Friction 

Coefficient, рис. 2.20. 
3) Кликаем ОК. 

 

Рис. 2.19 
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Рис. 2.20 

 Теперь коэффициент поверхностного трения будет доступен в раз-
деле Results 
Для построения этого параметра вдоль стенки трубы выполним дейст-
вия: 
1) Results→Plots→XYPlot→SetUp 
2) В качестве Y Axis Function выбираем Wall Fluxes и Skin Friction 

Coefficient, рис.21. 
3) Остальные настройки показаны на рис. 2.21. 
4) Жмем кнопку Plot. В графическом окне, рис. 2.22, появится распре-

деление местного коэффициента трения вдоль стенки трубы. 
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Рис. 2.21 

 

 

Рис. 2.22 
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 Коэффициент сопротивления по всей боковой поверхности можно 
определить двумя способами. 
Первый способ: Найти средне интегральное значение от местного ко-
эффициента трения по боковой поверхности трубы. 
1) Results→Reports→Surface Integrals→SetUp 
2) В появившемся окне Surface Integrals в разделе Report Type выбрать 

Area–Weighted Average, в разделе Field Variable выбрать Wall Flux-
es и Skin Friction Coefficient, в разделе Surfaces выбрать wall. 

3) Нажать кнопку Compute. В окно консоли будет выведено число 
0.0087826382. 

Второй способ: Используя возможности раздела Force. 
1) Results→Reports→ Force→SetUp. 
2) В появившемся окне Force Reports  в разделе Options выбрать Forc-

es, в разделе Wall Zones выбрать wall. 
3) Нажать Print. 
4) В окно консоли будет выведена информация о силах, действующих 

на боковую поверхность канала, и коэффициентах. Смотрим число, 
стоящее под coefficients и Viscous: 0.0087826389. 

2.6.2. Контроль и проверка решения 

 Для проверки выполнения интегральных законов сохранения (со-
хранение массы и импульса) можно поступить аналогично тому, как 
было описано в задаче о ламинарном течении в трубе.  
 Сравнение можно провести и с имеющимися экспериментальными 
данными по коэффициенту сопротивления λ для трубы, который опре-
деляется из формулы: 

21
2 av

P D

Lu
l

r
D=

�

, 

где PD  – перепад давления вдоль трубы. 
 Коэффициент сопротивления λ связан с коэффициентом трения CD 
зависимостью: 

4
D
Cl = . 

 Известна формула Г. Блазиуса для коэффициента сопротивления 
турбулентному течению в гладких трубах с поперечным сечением 
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круглой формы, которая справедлива для чисел Re от 4·103 до 105, где 

Re
av
u Dr m= � :  

0.25

0.3164
Re

l = . 

 Для чисел Re>105, более точной является экспериментальная фор-
мула Никурадзе 

0.237

0.2210.0032
Re

l = + . 

 Тогда касательное напряжение на боковой стенке трубы будет вы-
числяться по формуле:  

2

8w av
u

lt r= �. 

 Для Re=104 и исходных данных ρ=1 кг/м3, u
ср

=1 м/сек, получаем 

величину касательного напряжения 0.003955 Па.  
 Определим эту величину с помощью FLUENTа. Выполним дейст-
вия: 
1) Results→Reports→Surface Integrals→SetUp 
2) В появившемся окне Surface Integrals в разделе Report Type выбрать 

Area–Weighted Average, в разделе Field Variable выбрать Wall Flux-
es и Wall Shear Stress, в разделе Surfaces выбрать wall. 

3) Нажать кнопку Compute. В окно консоли будет выведено число 
0.0043913191 

 Как видим, расхождение между экспериментальным значением и 
расчетным составляет 11%. 
 Другой способ проверки – нахождение отношения максимальной 
скорости жидкости (на оси) um к средней скорости uср. Известно, что 
профиль скорости развитого турбулентного течения жидкости в трубе 
для чисел Re от 104 до 106 с достаточной степенью точности аппрок-
симируется следующей формулой:  

1/7

( ) 1
m

y
u y u

R

æ ö÷ç ÷= -ç ÷ç ÷çè ø
, 
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где R – радиус трубы. 
 Тогда выражение для средней скорости имеет вид: 

2
0

2 49( )
60

R

m
u u y ydy u

R
= =ò� . 

Согласно проведенным расчетам отношение um/uav составляет 1.195, 
что на 2.4% меньше «точного» значения 60/49=1.224.  
 Результаты расчетов также можно проверить, используя тот факт, 
что в теории турбулентного движения профиль скорости жидкости 
вблизи стенки (в турбулентном погранслое) является логарифмиче-
ским. Для определения местного коэффициента трения 

( )20.5
D w
c ut r= �  имеет место уравнение: 

2 12.5 ln Re 1.75
2 2

D

D

c

c

æ ö÷ç ÷ç ÷= +ç ÷ç ÷ç ÷è ø
. 

 Решение этого нелинейного уравнения для Re=104 дает величину cD 
= 0.007719, которая меньше рассчитанного значения 0.0087826389 на 
13.8%. 
 Логарифмический профиль скоростей в турбулентном погранслое 
позволяет определить отношение осевой скорости к средней скорости 
потока um/uav: 

12.5 ln Re 5.5
2 2

12.5 ln Re 1.75
2 2

D

m

av D

c

u

u c

æ ö÷ç ÷ç ÷ +ç ÷ç ÷ç ÷è ø
= æ ö÷ç ÷ç ÷ +ç ÷ç ÷ç ÷è ø

�
, 

 
которое равно 1.233, что на 3.1% выше полученного из расчетов. 

2.7. Задание для самостоятельной работы 
 Решите задачу о развитии турбулентного течения несжимаемой 
жидкости в трубе длиной 8 метров, диаметром 0.2 метра. Плотность 
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жидкости 1 кг/м3, вязкость жидкости 0.00002 Па⋅с, скорость жидкости 
на входе в трубу 1 м/с. 
 Для решения используйте FLUENT, схему второго порядка аппрок-
симации для уравнения сохранения импульса. Решение требуется по-
лучить на разностных сетках 100 × 15, 100 × 30, 100 × 60 (осевое раз-
биение × радиальное разбиение). 
 Для получения правильного решения задачи о турбулентном тече-
нии в трубе, необходимо помнить, что первый пристенный узел разно-
стной сетки должен лежать либо в вязком подслое, либо находится в 
области, где имеет место логарифмический профиль скоростей. Т.е. 

должно выполняться какое-либо из двух неравенств: 5y+ < , либо 

70y+ > , где w yy
t
r n

+ = ; ν – кинематическая вязкость жидкости, 

м2/с. Для определения величины y+  необходимо выполнить следую-

щие действия: Display→Contours. Далее в окне Contours of выбрать 
поле Turbulence и поле Wall YPlus. Далее кликнуть на кнопку Compute. 

В окне Max появится значение величины y+ . Убедитесь, что оно 
меньше 5. 
1. Постройте профили осевой скорости на выходе из трубы, получен-
ные на трех различных сетках. Также постройте профиль скорости, 
полученный из решения задачи о развитом течении несжимаемой жид-
кости в трубе постоянного сечения. На одном графике должно быть 4 
кривых. Осевая скорость должна быть отложена на оси абсцисс, а ра-
диальная координата – по оси ординат.  
2. Рассчитайте сдвиговое напряжение 

w
t  на стенке в области полно-

стью развитого течения на трех сетках. Рассчитайте это значение из 
теории полностью развитого течения жидкости в трубе. Для каждой 
сетки рассчитайте ошибку относительно аналитического решения. 
Поместите результаты расчетов в таблицу:  
 

Сетка 
xy
t  % ошибка 
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3. На выходе из трубы, где течение полностью развитое, ошибку в осе-
вой скорости на оси симметрии можно определить как 

calc exzct

exzct

u u

u
e

-
= �

�
 

Ожидается, что ошибка будет иметь вид: pK re = D , rD  – размер 
ячейки в радиальном направлении, K и p – постоянные, значение кото-
рых будет зависеть от выбранной разностной схемы. Используя метод 
наименьших квадратов, предварительно прологарифмировав зависи-
мость ln ln lnK p re = + ⋅ D , найти постоянные K и p. 
4. Посмотрите, как изменится значение p при смене разностной схемы 
с "second-order upwind" на "first-order upwind". На графике должно 
быть изображено четыре кривые. По две для каждой разностной схе-
мы. Сравните значения p и дайте объяснение полученным результатам. 
Следует помнить, что схемы второго и первого порядка точности при-
меняются только для инерционных членов уравнения сохранения им-
пульса, а дискретизация вязких членов всегда имеет второй порядок 
точности. 
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3. ЗАДАЧА О КОСОМ СКАЧКЕ УПЛОТНЕНИЯ 

3.1. Описание задачи 
 Рассматривается задача о течении сжимаемого газа, набегающего 
со сверхзвуковой скоростью на бесконечный клин с углом при верши-
не 2θ. На рис. 3.1 приведена схема картины течения, ось x соответству-
ет линии симметрии клина. Начальная скорость потока U больше ско-
рости звука, U > c. В зависимости от величины угла θ и числа Маха, 
соответствующего начальной скорости потока, возможно возникнове-
ние косого скачка уплотнения с углом между линией скачка и направ-
лением набегающего потока β. 

 

Рис. 3.1 

 
 Будем рассматривать течение газа в области со следующими раз-
мерами: АВ = 10 м, ВС = 5 м, θ = 30°, AA1 = 10 м (см. рис. 3.2). Счита-
ем, что на клин (ВС) набегает поток воздуха с плотностью ρ = 1.225 
кг/м3, вязкостью μ = 2·10–5 Па·с, давлением p = 101325 Па. Скорость 
набегающего потока характеризуется числом Маха М = 3. 

 

 

Рис. 3.2 
 
Решение задачи выполним, используя FLUENT с помощью 

ANSYS Workbench. 
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3.2. Создание проекта в ANSYS Workbench 

1) Запустите ANSYS Workbench: Start> All Programs> ANSYS 
14.0> Workbench 14.0. Окно Workbench показано на рис. 3.3.  

 

 

Рис. 3.3 
 
В левой стороне окна Workbench будет находиться панель инстру-

ментов, заполненная системами для решения различных физических 
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задач. Посредине будет организован создаваемый проект. В окне Anal-
ysis Systems дважды кликните левой клавишей мыши по строке Fluid 
Flow (FLUENT). После этого окно Workbench будет выглядеть как на 
рис. 3.4. 

 

 

Рис. 3.4 
 
2) Сохраните проект под именем Angle_shock_wave. 
3) В окне Project Schematic (окна Workbench) кликните правой 

кнопкой мышки на Geometry и выберите Properties, как показано на 
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рис. 3.5. В правой части окна Workbench появится окно Property of 
Schematic. 

4) В окне Property of Schematic, в разделе Advance Geometry Op-
tions измените значение Analysis Type на 2D, поскольку далее мы бу-
дем использовать двумерную модель течения газа.  

 

 

Рис. 3.5 
 
5) В окне Project Schematic дважды кликните левой клавишей мы-

ши на Geometry чтобы начать подготовку построения геометрической 



97 
 

области. При этом произойдет запуск программы ANSYS Design 
Modeler. Вам будет предложено выбрать желаемую единицу измере-
ния длины, рис. 3.6. Выберите метры и нажмите ОК. 

 

 

 Рис. 3.6 

3.2.1.  Создание эскиза 

1) В панели Graphics в нижнем правом углу кликните левой кноп-
кой мыши по оси +Z. После этого плоскость ХY совпадет с плоско-
стью экрана. (Ось +Z будет смотреть на вас), рис. 3.7. 
 Чтобы приблизить или отдалить изображение на панели Graphics, 
следует кликнуть левой кнопкой мыши по панели и, вращая колесико 
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мышки, можно добиться желаемого результата. Если возникает необ-
ходимость переместить изображение влево, вправо, вверх, вниз, то 
следует кликнуть правой кнопкой мыши и в контекстном меню вы-
полнить следующую последовательность действий: Cursor Mode→Pan. 

После этого курсор примет форму . Кликнув по панели Graphics 
левой кнопкой мыши и удерживая ее, можно перемещать изображение 
в любом направлении. 

 

 

Рис. 3.7 
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2) Эскиз будем создавать в плоскости XY. Для этого на панели 
Tree Outline кликните по ХYPlane (рис. 3.7). В левом нижнем углу па-
нели Tree Outline выберите закладку Sketching. Вместо панели Tree 
Outline появится панель Sketching Toolboxes – панель инструменталь-
ных средств для построения эскиза, рис. 3.8. По умолчанию открыва-
ется набор инструментов Draw. 

3) Перед построением области покажем координатную сетку. Для 
этого на панели Sketching Toolboxes кликните по табулятору Settings, 
находящемуся внизу панели, затем – по инструменту Grid и напротив 
Show in 2D установите галочку, рис. 3.9. После этого на панели 
Graphics будет показана координатная сетка, расстояние между коор-
динатными линиями по умолчанию равно 5 м. Перейдите в набор ин-
струментов Draw. 

 

                       

  Рис. 3.8                Рис. 3.9 
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4) На панели Draw в Sketching Toolboxes выберите Line и построй-

те 5 линий, ограничивающих область расчета, рис. 3.10. Для построе-
ния первой линии кликните левой кнопкой мыши в начале координат, 
затем проведите прямую в направлении оси х. Вторую линию построй-
те из конца первой линии под углом к оси х. Из конца второй линии 
строится третья линия и так далее до получения пятиугольника, каче-
ственно соответствующего рис. 3.2. Если курсор вести вдоль оси х, то 
рядом с курсором появляется буква Н, вдоль оси y – буква V, если кур-
сор поместить в начало координат, то рядом с ним появляется буква Р. 

5) Нанесем размеры на пятиугольник. На панели Sketching 
Toolboxes выбираем табулятор Dimensions → Generals. На панели 
Graphics подводя курсор к левой стороне пятиугольника, нажимая и 
удерживая левую кнопку мыши, отводим курсор влево. При этом поя-
вятся линии разметки. Такие же действия проделываем с нижней сто-
роной и с наклонной стороной пятиугольника, только курсор отводим 
вниз. Для нанесения угла выбираем в табуляторе Dimensions опцию 
Angle, выделяем наклонную и нижнюю горизонтальную линии и ведем 
курсор вверх до появления разметки. На панели Details View, которая 
находится под панелью Sketching Toolboxes, в группе Dimensions: 4 
устанавливаем размеры пятиугольника соответствующие входным 
данным задачи. Для того, чтобы вместо названий линий нанести на 
рисунок размеры фигуры выбираем на панели Sketching Toolboxes 
вкладку Dimensions, далее выбираем опцию Display и устанавливаем 
флажок на поле Value. В результате мы получили фигуру с нанесен-
ными размерами, представленную на рис. 3.10.  
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Рис. 3.10 

3.2.2.  Создание поверхности 

1) Для создания поверхностей выбираем в меню Concept, а затем 
Surface From Sketches, как показано на рис. 3.11. 

 

 

Рис. 3.11 
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Рис. 3.12 

 
2) На панели Tree Outline, выберите Sketch1, затем на панели 

Details View, напротив Thickness (>=0), выберите толщину 0.1m.  На-
против Base Objects кликните Apply. Окончательно кликните Generate, 
чтобы сгенерировать поверхность, рис. 3.12. 

3) На этом можно закрыть Design Modeler и вернуться в Workbench 
Project Schematic для построения разностной сетки.  

3.2.3.  Построение сетки 

Будем решать задачу на равномерной сетке с фиксированным раз-
мером ячеек. Заходим в меню Mesh (рис. 3.13) 
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Рис. 3.13 
 
1) Генерируем сетку: Generate Mesh (рис. 3.14). 
 

 

Рис. 3.14 
 
2) Применяем стиль Mapped Face Meshing. Для этого на панели 

Outline кликаем Mesh. Затем на панели инструментов выполняют по-
следовательность Mesh Control→ Mapped Face Meshing, рис. 3.15. 
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Рис. 3.15 
 
3) Кликаем по геометрической области, после чего она окрашива-

ется в зеленый цвет. После этого кликаем Apply на панели Details of 
“Mapped Face Meshing”, рис. 3.16.  

 

 

Рис. 3.16 
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3.2.4. Задание узлов сетки на границах 

1) Сначала зададим число разбиений вдоль левой вертикальной 
границы (линия АА1, рис. 3.2). Для этого кликаем Mesh Control > Siz-
ing (рис. 3.17). 

 

Рис. 3.17 

 

 

Рис. 3.18 
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2) Кликаем по фильтру Edge . Затем подводим курсор к линии 
АА1, рис.3.2 (она при этом окрасится в зеленый цвет), нажимаем 
левую кнопку мыши. После этого кликаем Apply на панели Details of 
“Sizing” (рис. 3.18). 

3) На панели Details of “Sizing” в поле Type выбираем Element Size 
и устанавливаем значение 0.2 (рис. 3.19) 

 

 

Рис. 3.19 
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4) Значение поля Behavior оставляем Soft (рис. 3.19). 
5) Проделываем аналогичную процедуру с п.1 по п.4 для других 

границ.  
6) После этого в строке меню кликаем Generate Mesh (рис. 3.20). 

Чтобы увидеть созданную сетку следует кликнуть на Mesh панели Out-
line. В разделе статистика панели Details of “Mesh” можно видеть, что 
число элементов получилось 3256.  

 

 

Рис. 3.20 
 
7) Можно поступить по-другому и задать на границах фиксиро-

ванное количество разбиений. Для этого в пункте 3 в поле Type нужно 
выбрать Number of Division. Построим сетку, задав значения разбие-
ний согласно геометрическим пропорциям области расчета. Так, для 
линии АА1 зададим 50 разбиений, линии ВС – 25 разбиений, линии АВ 
– 50 , тогда линии А1С1 соответствует 75 разбиений, линии СС1 – 25. 
Количество элементов равно 2625. 

8) Будем решать задачу на сетке, содержащей 2625 элементов.  
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3.2.5.  Присвоение имен границам области  

1) Левую границу области (линия АА1, рис. 3.2) назовем Inlet, пра-
вую (линия СС1, рис. 3.2)– Outlet, нижнюю прямую (линия АВ, 
рис. 3.2) – Symmetry, нижнюю линию, направленную под углом (линия 
ВС, рис. 3.2) – Wall_Conus, верхнюю (линия А1С1, рис. 3.2) Wall. Эти 
имена пригодятся на последующих шагах при построении модели с 
помощью программы Fluent. 

2) Выполните клик правой кнопкой мыши по свободному полю, 
где нарисована область с построенной сеткой. Из строки Cursor Mode 

выберите фильтр Edge . Подведите курсор к левой границе, когда 
она окрасится в зеленый цвет, выполните левый клик мышкой, после 
этого выполните правый клик мышкой. В появившемся контекстном 
меню выберите Create Named Selection, рис. 3.21. 

3) Появится окно Selection Name, рис. 3.22, в которое следует вве-
сти Inlet. Нажать ОК. Подобную операцию проделать со всеми грани-
цами, вводя соответствующие имена. 

 

    

             Рис. 3.21           Рис. 3.22 
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3.2.6.  Сохранение, выход, обновление 

1) Сохраните проект. File→Save project 
2) Закройте окно Meshing. File→ Close Meshing. 
3) Перейдите в окно Workbench и обновите проект, нажав на кноп-

ку Update Project, , которая находится под строкой 
меню. 

4) Окно проекта примет вид, рис. 3.23:  
 

 
Рис. 3.23 

3.3.  Запуск ANSYS FLUENT 

1) Чтобы считать геометрию и сетку во FLUENT кликните правой 
кнопкой мыши по Setup и в контекстном меню выберите Refresh 

2) После этого следует кликнуть на Update. В правой части ячейки 
Setup должен появиться знак вопроса, который означает, что процесс 
еще не завершен. Эти же действия можно выполнить с помощи панели 
инструментов, находящейся под строкой меню. 

3) Дважды кликните на Setup. Загрузится FLUENT Launcher. 
4) В разделе Options поставьте галочку рядом Double Precision. 
5) Нажмите на ОК. FLUENT будет запущен. 
6) Проверяем информацию о разностной сетке Mesh→Info→Size. 
7) Проверяем сетку на наличие ошибок Mesh→Check. 
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3.3.1. Установки Problem Setup 

1) Для получения решения выберем установки, соответствующие 
нашей задаче. Рассмотрим по пунктам, что мы задаем в разделе 
Problem Setup (рис. 3.24).  

2) Выбираем тип решателя. В разделе General ставим галочку воз-
ле Density-Based Type.  

3) Выбираем модель, в рамках которой будем проводить решение. 
Включаем уравнение энергии: Problem Setup → Models→ Energy→On. 

4) Устанавливаем модель невязкого течения: Problem Setup → 
Models→Viscous→Inviscid→ Ok.  

5) Получившаяся окно Models показано на рис. 3.25 
 

       

                 Рис. 3.24         Рис. 3.25 
 
6) Задаем свойства газа. В разделе Materials выбираем Fluid – air 

(стоит по умолчанию) и задаем свойства воздуха. Для этого нажимаем 
Create/Edit, в поле Density задаем идеальный газ – ideal gas, в поле Cp 
(теплоемкость) выбираем constant со значением 1006.43 Дж/кг/К, в 
поле Molecular Weight (Молярная масса) выбираем constant со значе-
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нием 28.966 кг/кмоль. Получившиеся свойства газа показаны на рис. 
3.26. Нажимаем Change/create и закрываем окно Create/Edit Materials. 

7) Задаем граничные условия. В поле Boundary Condition выбираем 
для границ inlet, outlet, wall тип (Type) Pressure-Far-Field. Для каждого 
из полей кликаем edit и выставляем свойства. Задаем Gauge Pressure – 
101325, Mach Number – 3, X-Component of Flow Direction – 1, Y-
Component of Flow Direction – 0. Во вкладке Thermal задаем темпера-
туру газа 300 К. Для границы wall_conus выставляем тип wall, для гра-
ницы symmetry ставим тип symmetry.  

8) Для проведения расчета задаем масштабные величины. Для это-
го во вкладке Reference Values выставляем значения, показанные на 
рис. 3.27. 

 

 

Рис. 3.26 
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Рис. 3.27 

 

3.3.2. Установки Solution 

Рассмотрим теперь установки решателя (рис. 3.28), для которых 
будем проводить решение задачи. Для решения поставленной задачи 
будем использовать алгоритм SIMPLE метода Патанкара, с привлече-
нием противопоточной схемы второго порядка точности для конвек-
тивных членов. 

 

Рис. 3.28  
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1) Выберем метод расчета. Во вкладке Solution Method задаем яв-

ный метод (Formulation-Implicit) и второй порядок точности (Flow-
Second Order Upwind). 

2) Во вкладке Solution Controls задаем значение числа Куранта, 
равное 5. 

3) Во вкладке Monitors кликаем по Residuals-Print, Plot, откроется 
окно, в котором мы можем регулировать величину «невязок», задаем 
во всех полях значение 10–6 (см. рис. 3.29). 

 

 

Рис. 3.29 

 
4) Во вкладке Solution Initialiazation задаем начальные данные. 

Выбираем Initialization Method – Standard Initialization. Во вкладке 
Compute from выбираем поле inlet и жмем Initialize. 

5) Во вкладке Calculation Activities можно задать автосохранение  
расчетов (Autosave), которое имеет смысл делать при проведении дли-
тельных расчетов, и при аварийной остановке можно возобновлять 
расчет с последней точки сохранения. Мы не будем устанавливать ав-
тосохранение, так как расчеты не предполагаются долгими. 
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6) Во вкладке Run Calculatoion выставляем число итераций - 10000. 
Если величина невязок будет меньше значения 10–6, то расчет прекра-
тится автоматически. Иначе, расчет будет идти до тех пор, пока не 
пройдет 10000 итераций. Перед началом расчетов сохраняем проект – 
Save Project. Кликаем Сalculate и смотрим на окно результатов. В окне 
результатов выдаются графики, соответствующие величинам «невя-
зок». 

3.4.  Результаты расчета 
Величина «невязок» в зависимости от номера итерации представ-

лена на рис. 3.30. Решение сошлось за 167 итераций. 
 

 

Рис. 3.30 

 
Ниже представлены распределения скорости (рис. 3.31), давления 

(рис. 3.32) и температуры газа (рис. 3.33), получившиеся при расчете. 
Результаты расчета соответствуют косой ударной волне.  
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Рис. 3.31. Распределение скорости газа 

 
 
 
 

 
Рис. 3.32. Распределение давления 
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Рис. 3.33. Распределение температуры газа 

 
Для того, чтобы как можно точнее рассчитать область течения в 

окрестности ударной волны, загустим разностную сетку в этой облас-
ти.  

1) Сначала покажем исходную сетку. Для этого выберем вкладку 
Results – Graphics and Animations– Mesh, в появившемся окне отметим 
все поверхности (Surfaces) и нажмем кнопку Display.  

2) Приступим к загущению сетки. Выберем вкладку Adapt – 
Gradient Adaption. На экране появится окно, показанное на рис. 3.34. 

3) В столбце Options отмечаем галочками пункты Refine и Coarsen. 
В столбце Method помечаем Gradient. Выбираем Gradients of Pressure – 
Static Pressure и нажимаем кнопку Compute. На экране отобразятся 
минимальное (min) и максимальное (max) значения градиента статиче-
ского давления. Переходной области соответствует область резкого 
изменения градиента давления.  

4) Откроем вкладку Results – Graphics and Animations–Contours. 
Выберем Contours of Adaption – Existing Value и нажмем кнопку Com-
pute. В графах min и max автоматически появятся значения, вычислен-
ные в предыдущем пункте. Снимем галочку с вкладки Node Value и 
нажмем кнопку Display. На экране отобразится картина без размыва-



117 
 

ния. Вы можете видеть, что зона резкого изменения градиента давле-
ния показана «квадратиками».  

 

 

Рис. 3.34 
 
5) Вернемся в окошко Gradient Adaption из пункта 3. В строке 

Refine Threshold введем значение 10000 и нажмем кнопку Mark. Это 
действие дает возможность отметить все точки, где градиент статиче-
ского давления больше 10000. Эти точки задают границу переходной 
области. Количество точек можно увидеть в окне консоли. Далее, в 
окне Gradient Adaption кликаем кнопку Adapt, в окне Results – Graphics 
and Animations– Mesh строим получившуюся сетку. На рис. 3.35 видно, 
что сетка изменила свой вид и имеет загущение в окрестности косой 
ударной волны. 

6) Проводим расчет задачи на новой сетке, для этого повторяем 
пункты 4 – 6 предыдущего раздела «Установки Solution». Скорость 
сходимости решения отличается от скорости сходимости для равно-
мерной сетки, что объясняется резким изломом сетки. Ограничим рас-
чет 200 итерациями и посмотрим на полученные результаты. Построив 
поле давления (рис. 3.36), можно убедиться в том, что область перехо-
да стала более узкой. 
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Рис. 3.35 
 
 

 

Рис. 3.36 
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3.5. Задание для самостоятельной работы 
Решите задачу о течении газа, набегающего со сверхзвуковой 

скоростью на бесконечный клин с углом при вершине 2θ. Характери-
стики области расчета и значения углов даны в таблице. Клин обтекает 
поток воздуха со следующими параметрами: ρ = 1.225 кг/м3, μ = 2·10-

5 Па·с. Статическое давление набегающего потока P = 101325 Па, тем-
пература Т = 300 K, число Маха М = 3. 

Решение проведите на двух сетках с размером ячейки 0.2 и 0.1. 
Сравните полученные решения. Проведите адаптацию (измельчение) 
каждой сетки в окрестности косой ударной волны. 

 
№ θ, град АВ, м ВС, м AA1, м 
1 40 15 7 10 
2 30 15 7 10 
3 20 15 7 10 
4 40 14 5 10 
5 35 14 5 10 
6 25 14 5 10 
7 40 14 5 12 
8 42 14 5 12 
9 38 14 5 12 

 
 Сравните полученные численные решения с точным решением 

этой задачи. Для получения точного решения выполните следующие 
расчеты:  

1) Определите угол наклона косой ударной волны к направлению 
набегающего потока β, который находится из следующего нелинейно-
го уравнения: 

( )
( )

β
2

2 2

1
ctg( ) tg( ) 1

2 sin ( ) 1

M

M

g
q

b

é ù+ê ú= -ê ú
ê ú-ê úë û

, 

где γ – отношение теплоемкостей, cp/cv; M – число Маха набегающего 
потока; В качестве решения этого уравнения следует брать первый 
положительный корень. 
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2) Найдите число Маха потока за косой ударной волной M1 из 
формулы:  

γ

2 2
2 2
1 2 2

( 1) sin ( ) 2
sin ( )

2 sin ( ) ( 1)
M

M
M

g bb q
b g

- +- =
- -

. 

3) Найдите статическое давление воздуха за косой ударной волной 
P1 из формулы: 

γ 2 2
1 2 sin ( ) ( 1)

1
P M

P

b g
g

- -=
+

. 

4) Найдите температуру воздуха за косой ударной волной Т1 из 
формулы: 

2 2
1 1

2 2

( 1) sin ( ) 2
( 1) sin ( )

T P M

T P M

g b
g b

é ù- +ê ú= ê ú+ê úë û
. 

5) Сравните результаты для M1, P1, T1 с результатами, полученны-
ми c помощью Ansys-Fluent. 
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